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This “Getting Started” training material is intended for new users of HFSS.

The objective is to provide a very thorough introduction to HFSS as applied to
antenna design, which may be followed step-by-step in HFSS with the investment of
only a few hours of time. The objective is not to provide a detailed and complete
enumeration of all HFSS capability which may be applied to antenna design, since
HFSS is a general and powerful design environment which may be applied in MANY
imaginative manners by experienced users.



Assumptions

+ The following assumptions are made

1. You have a license to run HFSS v9 and Optimetrics v3

2. You have HFSS installed on your computer

3. Your computer will execute HFSS effectively
+ Intel P4 or AMD Athlon class CPUs, 1GHz or faster

4. Your computer has adequate RAM (512Mb)

5. You have adequate local file system storage (1Gb)
for the configured temporary directory

6. You are storing HFSS designs to a local file system

7. You have a reasonable graphics card with the latest
drivers and a high resolution monitor
+ 32Mb RAM or more, current generation graphics chip
+ 1280x1024 or higher
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HFSS usage is restricted to registered licensees.

HFSS is a high value EDA solution that greatly reduces engineering time
investments for high frequency and high speed EM-based designs.

HFSS requires significant computer resources. These assumptions are considered
to be minimum requirements.



Learning Objectives

+ The objectives of this multi-part exercise are

+ to introduce you to the basic level capabilities of HFSS for
antenna analysis and design

+ to allow you to perform the same tasks using HFSS for
yourself in order to quickly learn to use HFSS
+ The exercise is not advanced but you are expected
to learn as you progress from task to task

«+ the instructions are detailed the first time a task is covered
but you are expected to know how to accomplish it on
your own the second (and later) time you are asked to
perform the same task

+ it may therefore be inefficient to skip sections too far
forward
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This exercise is intended to help you to learn to use HFSS to successfully design
antennas. Following the tasks using HFSS is the most effective manner in which to
accomplish this objective.



A Simple Antenna

» A simple rectangular waveguide (RWG) radiator
terminated in an infinite ground plane will be
examined.
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A simple aperture radiator in an infinite ground plane is examined but the concepts
learned apply equally well to all antennas.




Analysis Flow

+ ltis instructive to examine antenna analysis using HFSS as
a process and examine its “flow”
+ The following steps comprise such a flow
a. Design Capture
b. Analysis
c. Post Processing
+ In more detalil
Create a parametric solid model for the geometry
Specify material properties
Specify boundary conditions and excitations
Specify analysis and frequency sweep setup information
Perform the analysis
Examine the results
Examine the fields
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EDA software automates what was previously accomplished much more manually.
EM-based analysis automation is not radically different from other types of electrical
design. The cited steps provide both a high level and a more detailed view of the
process, demonstrating there is much more to EM-based analysis than performing
the analysis.



Design Flow

+ Portions of this analysis flow may be repeated in an iterative
loop as the antenna is modified to achieve desired
performance specifications. Let’s term this as “design flow”

+ This is accomplished conveniently with automation provided
by HFSS in the form of
1. Parametric Sweeps
2. Optimization
3. Sensitivity Analysis
4. Statistical Analysis

+ HFSS supports these capabilities with
+ an inherently parametric design environment
+ management of parametric solutions results
+ display of parametric geometry, results and fields
+ export of parametric results for use in circuit analysis
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“‘Design” may be considered distinct from “analysis”, supported by a wrapper of
automation surrounding the “analysis” process.

In addition to support of analysis, HFSS provides many capabilities to support
higher level design and Design for Manufacturing (DFM).



The Sections of this Exercise

+ The sections of this exercise are titled
HFSS and the Desktop Design Environment
Draw the Antenna Geometry

Define the Excitation Port

Specify Boundary Conditions

Mesh Control

Analysis Setup and Frequency Sweeps
Perform and Track the Analysis

Post Processing — Reports for Results
Post Processing — Radiation

Post Processing — Field Displays

. Parametric Sweeps

Optimization

Advanced Topics
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This sections of this exercise should be followed sequentially, since many concepts
introduced in earlier sections are assumed knowledge for later sections.



Section 1
HFSS and the Desktop Design Environment

+ The objectives of this section are to introduce
+ the HFSS Design Environment
+ called the “Ansoft Desktop”
+ some basic configuration specifications
« the concept of a project and a design

NOTE

this same Desktop is used as the Design Environment for Ansoft Designer

« Ansoft Designer supports an integrated design flow across the applications
+ planarEM
+ circuits - linear and nonlinear, frequency and time domain
+ system-level
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The Graphical User Interface of HFSS is an environment to support EM-based

design, commonly called a “Design Environment”, specifically called the [HFSS]
Desktop.

This same Desktop is used to support planarEM/circuit/system level design for the

EDA solution Ansoft Designer. Learning HFSS will greatly facilitate the learning of
Ansoft Designer.



Executing HFSS

+ Double click the Windows desktop icon
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For a PC platform, HFSS may be launched by double clicking the Windows desktop
icon shown or via the Start button.

HFSS design files may be opened with HFSS by double clicking and the icon/name
of an HFSS design file, which is saved with an extension of “.hfss”. Alternately, you
may right clicking on the HFSS design file icon/name and selecting Open at the top
of the context sensitive menu.



The HFSS Desktop

Project
Tree

Progress display
Window

The HFSS design environment, the Desktop, is shown with its basic components.
The windows are configurable; size, visibility, dockable, etc. Menu bars dynamically
change with design flow status and are fully customizable. Such user-specific
configurations are stored in the registry for future HFSS sessions.

The Project Tree displays a hierarchical view of all open projects, designs and all
components of designs.

The Properties Window is used to display and edit attributes of active components
of the Desktop.

The Message Window provides informational, warning and error messages.

The Progress Window displays status for analyses, optimizations and other
potentially lengthy processes.

The Status Bar is used to display miscellaneous messages, command hints and
(x,y,z) coordinates.

The Graphical Window is used view solid models, reports of results, field displays,
etc.

The visibility of these windows is controlled from the main menu item “View”. If your
desktop does not exactly look like this (and you want it to do so) you can change
window visibility, size, docking, etc.



Configure HFSS
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HFSS and many of its individual functionalities may be configured with user defined
options.

If required, change the default configuration of HFSS to use local disk for both
project directories and TEMP files.

Many other aspects of HFSS may be configured for user preferred behavior so
please make note of the location for the “Options” menu items for future tuning of
HFSS to meet your personal preferences.



Save the HFSS Project

Save As
S s =

Savein I 1) Antenna_Class_Projects

I
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File name: — [RW/G_aperture_antenna Save

Save astype: [Ansoft HFSS Project Files [ ifss) = Cancel
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When HFSS is executed it opens with a new project, shown in the previous pages.
The default name of this project is “Project<n>”, where <n> is selected to create a
unique file name.

To work with a project of logical name saved in known location, you should consider
immediately applying the menu item “File > Save As ...”. The menu command and
the resulting dialog are shown. To subsequently save this design the menu item
“File - Save” or the corresponding toolbar icon may be applied.

Remember to always use local disk for projects for which you will perform analyses,
since remote disk access will show analysis.



Project Hierarchy
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“Projects” are displayed in the Project Tree window with the green symbol shown
here. To expand the hierarchy of a project or any of its components simply click on
the ‘+’ sign to the left of the project icon in the Project Tree. The project hierarchy
will expand and the ‘+’ sign will change to a ‘-’ sign. To collapse the hierarchy of the
project, simply click on the ‘-’ sign.

Notice that very little now appears in the project hierarchy.

HFSS may simultaneously access multiple projects.



Insert a Design

A “design” is a unique geometry for analysis by HFSS. Each “project” may contain
multiple “designs”, any of which may be accessed simultaneously.

At this time you should add a design to your project. There are three manners in
which you may accomplish this.

1. click on the blue toolbar icon shown above

2. right click on the green project icon and apply the context sensitive menu item
“Insert > Insert HFSS Design”

3. apply the main menu item “Project 2 Insert HFSS Design”

It is important to note these three manners in which to accomplish many common
tasks in HFSS: toolbars, right clicking, menus



A New Design
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The graphic show the Desktop after the new design is added.
A blue design icon is added to the model hierarchy with a default name.

The graphical window contains a blank solid model and the context sensitive toolbar
has changed to support solid modeling within this new window.



Rename Your Designs
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It is very wise to immediately rename your designs.

This is accomplished as show on the left by right clicking on the design icon and
applying the “Rename” menu item.

The name selected here is “RWG_aperture_radiator”.

Note that the hierarchy of the design in the Project Tree has been expanded to
show its component parts. Design hierarchy is expanded and collapsed in exactly
the same manner as for a project.

It is important to note the *’ to the right of the project and design names in the
hierarchy. These symbols indicate the project (or design) has changed and these
changes have not been saved.



Section 2
Draw the Antenna Geometry

+ The objectives of this section are to introduce
« solid modeling setup, configuration and options
+ basic solid modeling concepts of HFSS
+ variables in HFSS
«+ the solid modeling history tree
+ solid model view controls and hot keys
+ selection display and mechanisms
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You will spend significant time performing solid modeling tasks, especially as your
designs become more geometrically complex. The HFSS solid modeling capability
is very powerful, general and robust and will likely support all your parametric
drawing needs.

HFSS also supports robust solid model import from external solid modeling codes.
HFSS applies the Spatial Technologies ACIS kernel. Therefore, “.sat” files are
directly imported. Translators are also available for import of “.step” and “.iges” files.



Set the Drawing Units
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Units for the design may be specified. The default units applied to new designs may
be configured for user preference.

Assure your design units are set to “mm”. Apply the menu item “3D Modeler -
Units...” and select “mm?” in the dropdown list of the dialog box shown to the right.

Mixed units may be used throughout the code by simply typing explicit units. For
example, the XSize attribute of a solid object may be specified as “1 mm” and the
YSize may be specified as “10 mil”. Units may also be mixed in expressions, where
the expression “d =10 mm + 1 cm” implying d =0.02 =2 cm = 20 mm.
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For effective drawing it is very useful to apply various snapping modes.

Snapping modes are accessed through the menu item “3D Modeler -> Snap
Mode...” and the resulting dialog box.

They are also easily accessed in the toolbars, with obvious highlighting for currently
active snapping modes.

It is very important to note the symbols to the left of the check boxes in the right-
most dialog. During drawing operations the cursor will change shape to these
symbols as it snaps to an entity activated by its respective snapping mode.



HFSS Uses a Drawing Plane
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Though HFSS supports a true 3D solid modeling environment, a 2D plane
specification is required for the local/drawing coordinate system. This coordinate
plane (XY,YZ,ZX) plane defines the “base” of the solid object. As seen for a
rectangular box in the following material, three mouse clicks are required to draw
3D solid objects. The first two mouse clicks are restricted to occur/snap in the
coordinate plane specified.

Again, there are multiple manners in which to specify the active drawing plane.
Show are

1. the menu item “3D Modeler - Grid Plane”, with the check mark indicating the
current selection

2. the indicated dropdown from the context sensitive, drawing window toolbar



Draw a 3D Rectangular Box
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To create a 3D rectangular box
1. click the indicated symbol in the toolbar
2. apply the menu item “Draw - Box”

Note the existence of “tool tips” when the mouse is held stationary over the toolbar
icon for the first of these two alternatives.



Three Mouse Clicks

As stated previously, solid objects are generally created with three mouse clicks.

The graphics show the cursor position and snap mode indicator (displaying grid
snap) for the three sequential mouse clicks.

The active drawing plane was XY. Notice the first two points snap to a grid
displayed for the XY plane and the third point defines a vertical offset.

It is not important to assure you snap to exactly the same grid locations as shown
above but assure your active drawing plane is XY.



Defining the Box

Ansoft HFSS - [RWG_aperture_antenna - RWG aperture radiator - 3D Modeler] -181x]
TJFle Edt Vew Pioject Draw 3DModeler HFSS Took Window Help T

[DEa:2@a8x o |nceee d||E|xo]-[m~ ot a2 E K
By vr S mes=tblo0esan|: v @ ]|®[ocum Mmool BT
alolx -6 Model

I Show Hidden

Cancel

Upon completion of the third mouse click a 3D rectangular box is displayed (in the
default purple selected object color) in the solid mode view. A dialog box is
displayed for the user to edit the properties/attributes that define the box.

HFSS may be configured such that this dialog box not appear immediately after the
third mouse click. In this case, properties/attributes that define the new box may be
edited in the Properties Window or by double clicking the appropriate icon in the
graphical tree immediately to the left of the solid model view.

Again, it is not important that your dialog box content exactly match that shown
here, since we will change it very soon.



Variables in HFSS

Properties: RWG_aperture_antenna - RWG aperture radiator - 30 Modeler x|

Add Variable to RWG aperture rai x|

Marme fyG_eight

™ Show Hidden

Yalue

7.5 mm|

=
Define variable walue with units: ™1 mm'*
" Local Yariable
) Broject Varizble

ANSOFT CORPORATION

In HFSS a variable may be applied nearly anywhere a numerical value is to be
specified. It is just as easy to create fully parametric solid models as fixed
dimension drawings. The newly created 3D rectangular box will be created with
variables.

Click in the Value field for the XSize Property and type the text (no quotes)
“WG_height”. When you click in a new field to press the TAB key this textual
variable name will be accepted and processed. HFSS recognizes this variable as
not yet being defined and presents you with a dialog to define its numerical value.
For this design, type “7.5 mm” as shown and click OK in the Add Variable dialog
box. This variable is now defined and ready for present and future use.

As you can see, applying variables is a trivial matter.

Had a more general expression been typed for the Value of XSize, the entire
expression would have been parsed and all new variables would need to be defined
through a similar process.



Complete Definition of the Box
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Complete the definition of the 3D rectangular box as shown above.

The “Command” tab of the dialog should be completed as shown on the left; defining all new
variables as required.

*WG_width = 15 mm
*WG_feed_length =15 mm

The “Attributes” tab of the dialog should be carefully and accurately completed as shown on the right.
Please specify the color of the box by clicking on the “Edit” button in the Value field of the Color
attribute. Select the object to be orange.

Similarly, to change the Material or Transparent attribute you would click on the button in the Value
field.

Click OK when completed.
If you make a mistake or prematurely cancel the properties dialog box for the new box

«click on the box in the solid model window (it will turn purple if it is not already)
eright click the mouse in the solid model window and select “Edit > Properties...”



View the Entire Geometry
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Your desktop environment may look like the left graphic.

To view the box in its entirety, as shown on the right, you can do one of the
following

«apply the menu item “View - Fit All > All Views”
eright click and select the context sensitive menu item “View - Fit All”
type “CTRL+d”

The box is purple because it is selected. To de-select the box, or all objects of your
future designs you can do one of the following

«apply the menu item “Edit > DeSelect All”
type “CTRL+SHIFT+a”

«click in the solid model view window anywhere the mouse is not positioned on top
any object



The Model History Tree
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The 7.5mm by 15mm by 15mm box is shown in the solid model view window.

If your solid model does not look like this, then click on the box in the solid model
view to select it. Then you can edit its Attributes or Command properties in the
Properties Window.

To the left this simple geometry is a graphical tree showing the hierarchy of the solid
model. This is called the “History Tree”. It is a graphical view of the history of the
creation process for the solid model. It is very useful and will be an aid to editing
future, more complex solid models.

The viewing area for the history tree can be expanded or contracted by positioning
the cursor as shown in the graphic and dragging the separator bar.

As solid models become complex it is often convenient to view solid model objects
in the history tree grouped by material property rather than alphabetical order. To
accomplish this, simply right click on the Model icon in the history tree and click on
the toggle “Group Objects by Material”. Try this now.



Drawing Window Mouse Functionality

Function Hot Key Cursor
Rotation Alt =
Translation Shift &
Zoom Alt + Shift &y
&
/ \.
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By default, the mouse function in the solid model window is to select objects or
faces.

There are three other modes for mouse operation in the solid model window:
Rotation, Translation and Zoom.

These alternate modes are used frequently during both the design capture phase
and postprocessing phase of the design flow

These mouse modes are accessed through the “View” menu items in either the
main menus or the right click context sensitive menus.

These modes are also available by keyboard hotkey, as shown. These hotkeys will
quickly become second nature to regular HFSS users and nearly the only
manner by which most user access these mouse functions.

When the mouse is in any of these alternate modes the cursor changes to the
shapes shown.



Preset Viewing Directions

®

There are 9 pre-defined viewing angles for the solid model view.

They are arranged in a 3-by-3 grid, as shown in graphic 1.

To change the solid model view to one of these pre-defined viewing angles
position the cursor in the one of these 9 locations
*hold down the ALT key (the cursor will change as shown)
*double click the mouse.

Graphic 2, 3 and 4 show three examples of these pre-defined views. The position of
the cursor is highlighted with a red square for each case.

Experiment with these viewing angles and choose one you like to view your
geometry.



Draw Another Box
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The dimensions are shown for the Command tab of the new box properties dialog.
The value of “BC_spacing” should be set to 20mm.

Draw a second 3D rectangular box.

The Attributes dialog should be configured identical to the previous box; except
this second 3D rectangular box should be named “air”, it should be green in color
and its translucency should set to 0.85

The resulting solid model and design tree should look like the graphic on the right.

As for the first box: if your solid model does not look like this select the object using
the cursor positioned in the solid model view and edit it using the Properties
Window.

The geometry is now complete!



Toggle the Grid Display
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The visibility of the drawing plane or so-called grid plane may be toggled on/off.

Turning off the grid visibility may be preferred for convenient visualization of
complex solid models.

This is accomplished through the toolbar as shown to the left or a dialog box
accessed by applying the menu item “View - Grid Settings...”

It is important to note that for grid snap mode to function the grid must be visible.



Change the Displayed Axes
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The display of the coordinate axes may be modified.
The axes may be hidden.

They may also be toggled between large and small axes. Small exes will be used in
future graphics.

This control is accessed through the menu items under “View - Coordinate
System”



Selection Mechanisms in HFSS
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The default function of the mouse in the solid modeling window is for object/face selection.

When the cursor is positioned over an un-selected object, its outline highlights. This is shown in
graphic 1. This highlight shows what object would be selected if the mouse is clicked.

When an object is selected, it is highlighted in the display color (by default, purple). All un-selected
objects are desensitized. A careful comparison of graphics 1 and 2 will demonstrate the orange box
is desensitized.

(hint) The translucency specification is applied to selected objects so for highly translucent objects it
may be difficult to distinguish what is selected, especially if there are objects with a color similar to
the selection color.

Selected objects are also indicated in the history tree. Further, the history tree may be used to select
objects by clicking on the objects within the history tree.

It is important to note that multiple objects may be selected in the solid model viewing area or in the
history tree by holding down the CTRL key as objects are selected. This is a Windows standard
behavior. Further, when selecting in the history tree the SHIFT key may also be used to select all
objects between and including the previous two mouse clicks.



Editing Object Properties
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As mentioned previously, the properties of selected objects are displayed and
edited in the Properties Window, shown at the bottom left in the graphic.

If more than one object is selected, then only the common attributes are displayed
in the Properties Window. This allows for rapid editing of a large group of objects
with a common attribute. The value of these common attributes are displayed if they
are the same for all selected objects. Remember that multiple objects may be
selected through the Windows-standard use of the CTRL key.

In this exercise both solid objects (RWG_feed and air) are selected, as indicated in
the graphic by the selection color and highlighting in the history tree. Since both
objects are boxes they should have all common properties. For example, since they

are both volumes of material property vacuum, this appears as a displayed common
value in the Properties Window.

For objects selected using the mouse in the solid model view, both the Attributes

and the Command properties are editable from separate tabs of the Properties
Window.



Face Selection in HFSS
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Selection mode toggles between object selection and face selection.

The easiest access to this toggle is through right clicking in the solid model view at
the top of the context sensitive menus.

Alternately, the select modes are found in the main menus under “Edit - Select”

The cursor driven highlighting select preview, select color and non-selected
desensitization work exactly the same for faces as they do for objects.



Section 3
Define the Excitation Port

+ The objectives of this section are to introduce
« defining and viewing ports
+ port “lines”
« renormalization and deembedding
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Defining excitations and ports is one of the most complex aspects of HFSS. With
regular use of HFSS, antenna designers will eventually apply nearly every type of
excitation available in HFSS. These ports include concepts such as: modes (single,
multiple, degenerate, etc), terminals, diff pairs, plane waves, polarization,
impedance ... and many other theoretical and practical concepts.

This introductory exercise covers the use of only one type of port, a “wave” port,
with only one propagating mode.
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Rotate the solid model view to have a perspective similar to that shown in graphic 1.
Change to face select mode.

Position the cursor over the face at the bottom of the RWG feed and click the
mouse.

As shown in graphic 1, the first face encountered by the cursor as it is projected into
the 3D view is the face selected. This is not the face to which the port should be
assigned.

As shown in graphic 2, right click the mouse and select “Next Behind” from the
context sensitive menus. This causes the selection to change to the next face the
cursor would encounter as it is further projected into the 3D view. As indicated in
graphic 2, this operation may easily be accomplished by typing the ‘b’ key.

Graphic 3 shows the desired face selection.
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As for many operations in HFSS, there are multiple manners in which to specify a
face as a port.

The easiest manner is shown. It is accomplished by right clicking in the solid model
view and applying the context sensitive menu “Assign Excitation > Wave Port...”

Alternately, a port may be assigned by

*right clicking the “Excitations” icon in the project tree and selecting the context
sensitive menu item “Assign - Wave Port...”

«applying the main menu item “HFSS - Excitations - Assign > Wave Port”



Port Properties
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This is the first tab of the wave port definition dialog.

The default name for a wave port is “WavePort<n>", where <n> is selected to yield
a unique name with n starting at a value of 1.

(hint) You may wish to use a shorter name, like “p1” shown above. As you use
HFSS more regularly you will appreciate why but for now choose a port naming
convention you like with short names and use it unless you find a reason to use
longer names or differentiate amongst the ports of a multi-port device.

Click Next to proceed.



Define an Integration Line
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When the dialog appears, click on None under “Integration Line” for “Mode” 1 and then select New
Line... from the dropdown list.

The dialog goes away and you are expected to click on two points; the endpoints of this new
integration line.

Assure edge center snap mode is enabled.

Snap to the edge center of the port along the negative X-axis for the first point and the edge center of
the port along the positive X-axis, as shown in the graphics. Recall that the cursor will change to
a triangle when snapped to the edge center. You may be required to turn off some of the other
shapping modes to reliably snap to where you wish.

After defining both points click Next to proceed

NOTE: The function of an integration line it threefold
1. the E-fields are aligned with the line to resolve potential minus sign errors

2. theintegral of E (dot) dL is performed along this line to compute a voltage, which is then used to
compute the power/voltage characteristic impedance

3. the third and rarely encountered use of the integration line is as a line of port field symmetry to
help polarize degenerate modes

(hint) Always define an “Integration Line” !l

It may not strictly be required in some cases (like this one) but you will regret having not defined one
at sometime in the not too distant future if you get in the habit of not defining one for each and
every port of each and every design.
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Specify the third dialog as shown and click Finish to proceed.

By default for wave ports, HFSS works with wave amplitude S-parameters normalized to the
characteristic impedance computed for transmission feed lines. A change of this S-parameter
reference impedance to a different value is called “Renormalization”. This can be specified prior
to analysis or changed after analysis without being required to re-compute the analysis.

If a shift of the physical location of the reference plane is desired the process is called
“Deembedding”. A positive value shifts the reference plane into the structure from where the port
was drawn (making the feedline shorter). A negative value shifts the referent plane out of the
structure (making the feedline longer).

NOTE: HFSS always performs these operations in the proper sequence, which is deembedding first
and renormalization last.

(hint) If either of these two operations are performed the adaptive refinement convergence criterion is
based on these deembedded and renormalized data as well as interpolating frequency sweep
convergence. This can help to achieve more accurate results for the final results you wish to
examine. However, it could cause issues for two reasons:

1. ahuge reference plane shift to greatly extend the length of a feedline could serve to add very
much electrical length to the results and may cause adaptive refinement process convergence
uncertainties.

2. areference plane shift (as described in 1.) causing additions of large electrical length or a large
impedance mismatch between the computed port impedance and the renormalization impedance
causing much less smooth S-parameters, may require more frequency samples for a converged
interpolating sweep. This is because the complex values are being interpolated and rapidly
changing phase or magnitude of S-parameters is more difficult to interpolate.
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To view the port and the orientation of the Integration Line, simply click on the port
icon in the design tree.

Assure your port is shown as in this graphic.

If the port is not setup properly, then double click on the port icon in the design tree.

A tabbed dialog will appear allowing you to set/modify the port specifications
covered in this section.



Section 4
Specify Boundary Conditions

+ The objectives of this section are to introduce
« defining and viewing boundary conditions
+ various boundary conditions
+ their function and attributes
« overlapping boundary conditions
+ treatment
+ manipulation
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Boundary conditions (BCs) specify behavior of the fields on surfaces. For example,
a perfect conductor has zero tangential electric field and a surface impedance
enforces a defined ratio between tangential electric/magnetic fields. There are
several types of boundary conditions in HFSS and we will explore many of them by
the time this multi-part exercise is completed.

Boundary condition assignment may most intuitively be viewed as a process of
painting surfaces. The final color of a painted surface is the color it was last painted,
which almost seems too logical to explicitly state. However, the analogy to BC
assignment is: the surface behavior of the fields is controlled by the last BC
assigned to that surface.

This section will cover assignment, viewing and manipulation of HFSS boundary
conditions.

The important analogy of painting surfaces will become obvious and should be
committed to memory.
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You should already know how to select faces and use the CTRL key to select
multiple faces.

You should know how to use the ‘b’ hot key for next behind face selection or
alternately know how to use the ALT key to rotate the geometry to sect hidden
faces.

Select the “top” and the four “side” faces of the air box.
When all five faces are selected, define a radiation boundary condition (BC).

The easiest way to apply the radiation BC is to use the solid model view (right click)
context sensitive menu item “Assign Boundary - Radiation...”. Alternately you can
access the same capability through the main menu item “HFSS - Boundaries >
Assign - Radiation...” or the context sensitive menu item “Assign - Radiation...”
of the Boundaries icon in the Project Tree.

The radiation BC dialog is shown on the right. Specify the name “Radiation_BC” to
this boundary.

It is not required but is a very good practice to rename your boundary conditions to
some meaningful name. In this manner, your colleagues who examine your design
files will know what you have done — or you will know what you've done when you
revisit your design next week.
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Notice the expanded Boundaries hierarchy of the Project Tree.

As for ports, clicking on the individual boundary conditions in the Project Tree will
highlight the boundary faces in the solid model view.

Select the boundary and use the mouse with the ALT key in the solid model view to
look at the design from various angles. Remember, you can always use the pre-

defined view angle 3-by-3 grid to return to a logical view angle. Simply position the
cursor, hold down the ALT key and double click the mouse.



View all Boundary Conditions

tor - 30 Modeler] S
o Heb Zlsix|
R L EEL

£ o

fSolver ¥iew of Boundaries

Marme | Tupe I Solver Wisibility | Visibility | Colorl
Radistion_... User Defined  Visible to solver,
pl User Defined  |Visible to solver, l_ [ |
outer Default isible to solver |_[}\ m
Close

5
o
i

|

ANSOFT CORPORATION

An alternate way to view the boundary condition specifications in HFSS is the main menu command
“HFSS - Boundary Display (Solver View)”

This is an important capability with which to familiarize yourself. Even though you examined the
highlighted radiation BC in the previous step, examine the boundaries of HFSS using this alternate
method.

The dialog box at the top right will appear. To view a boundary, simply click in the Visibility box for
that boundary.

IMPORTANT !l

The graphic at the bottom is the implicit boundary called “outer” displayed as bright green. All exterior
faces of the object that are not included in the previously defined boundary conditions (port and
radiation BCs) are part of the implicit BC “outer”. Please examine this BC in this manner and use the
rotation (ALT) function of the mouse to view the geometry from various angles to fully understand
what faces are part of “outer”.

“Outer” must be some type of condition, since it is the end of the Finite Element universe. For HFSS
this default type of boundary for “outer” is perfect conductor, called “PerfectE” in HFSS. You will
discover that the four RWG feed line sidewalls are part of outer, as is the XY plane (except for the
aperture).
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As just discussed, the default condition of the ground plane is already a perfect
conductor (“PerfectE”) since it is part of the “outer” boundary. This default BC could
be applied to correctly analyze the design for the S-parameters of this one port
device. However, when the far fields are computed energy should only be radiated
into the positive-Z upper half space. To enable this post-analysis processing to be
performed correctly we are required to specify the bottom surface of the “air” box as
an infinite ground plane.

Select the bottom face of the “air” box (in the z=0 XY plane)
Assign this face to have a boundary condition of type “PerfectE”

The PerfectE BC dialog is shown to the right.

Name the BC “Ground_Plane” and specify it to be an Infinite Ground Plane by
clicking in the check box.



Define the Aperture

Select Ohjects
[v Select Fares F

ezt Behind B
Al Object Faces

Perfect H Bountary x|
Narme: [Aperture]

MeasLre 3

Vi »

Edit »

2 /cci0n [VaterEl
Assign Boundary

Perfect E...

»
Assign Excitation 3

Assign Mesh Operation »  Finite Conductiity.
T rree s Impednce.
Layered Impedance. ..
T Radiation

Copy To Clipboard Syrmmetry.
— Master.
Slave...
Lumped RLC..,

Piot Fields
Piot Mesh

PML Setup Wizard..,

Corcel

ANSOFT CORPORATION

The antenna aperture, the face intersection between the RWG feed line and the air box in the Z=0
plane, was just painted over with a PerfectE boundary condition.

If this is not intuitively obvious, you can use the “HFSS - Boundary Display (Solver View)” main
menu item to once again view all the BCs for all surfaces.

There should be continuity of [tangential] fields across the aperture surface between the volume of
the RWG feed line and the upper air box. The now-present PerfectE BC must either be removed or
painted over with something to enforce this continuity. The “PerfectH” BC accomplishes this.

Select the aperture face - you may be required to use the ‘b’ hotkey (next behind) capability
Assign a PerfectH BC named “Aperture” to this surface, as show in the dialog box to the right.

IMPORTANT

An exterior face has meshed volume on only one side while an interior surface has meshed volume
on both sides.

A PerfectH surface on an exterior surface enforces the condition of zero tangential magnetic field.

In contrast, an interior PerfectH surface is treated much differently. Since HFSS treats internal faces
with tangential field continuity this is the “Natural BC” applied to an interior PerfectH surface.
Continuing the painting analogy, interior PerfectH surfaces are painted with paint remover.
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The leftmost view of the Project Tree hierarchy shows the three BCs you defined.

You are able to view individual BCs by selecting the logically named BC in the
Project Tree. However, it is important to note some of these surfaces may have
subsequently been painted over by other BCs. As stated previously and well worth
repeating, now would be a good time to examine the overall effect of all defined
BCs. This is accomplished with the now-familiar main menu item “HFSS -
Boundary Display (Solver View)”.

Port excitations always have highest priority, as if they were painted last.

If you find the ordering of the boundary condition assignment must be changed to
achieve the desired overall effect you may use the context sensitive menu item
“Reprioritize...” by right clicking the Boundaries icon in the Project Tree. This menu
item and the resulting dialog are shown to the right. To reprioritize BCs, simply click
and drag the gray square to the left of the Priority value column. Lowest priority BC
specifications correspond to the first color painted and Highest priority BCs
correspond to the last color painted.



Section 5
Mesh Control

+ The objectives of this section are to introduce
+ mesh seeding and control
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This section is completely optional and might even be considered an “Advanced
Topic”.

HFSS users with numerical techniques expertise will desire control over the mesh
used to approximate a geometry or the density of surface or volumetric mesh
densities in specific regions.

It is well beyond the scope of this multi-part exercise to treat such considerations.
This section is only the most brief of introductions to the location of such capability
within the HFSS Desktop environment and where it fits in the overall antenna
design flow. Further investigations in this area are left to the advanced user.
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At a radiation boundary the electromagnetic equivalence principle is applied. The equivalent surface
currents are radiated/propagated to the far field through the use of a greens function. The accuracy of
the far fields is therefore dependent upon the accuracy of the radiation surface currents, which is
directly related to the mesh density on this surface. You will be asked to specify a meshing operation
on the radiation BC surface to increase the surface mesh density.

Sele)ct the same five faces as you selected for the radiation BC (the top and four sides of the top air
0X

Apply the solid model view context sensitive menu item “Assign Mesh Operation > On Selection >
Length Based...”

The dialog box for specifying this mesh operation is shown in the middle of the page.
Specify a 3mm maximum mesh element edge length mesh operation named “Radiation_BC_Seed”.

NOTE: This specific length was selected because at the lowest frequency of operation for this
antenna (about 10GHz due to the 10GHz cutoff frequency for the dominant mode in the RWG feed
line) 3mm is about one tenth of a wavelength. In practice this mesh density is not required but it
serves the purpose of demonstrating the advanced capability for this multi-part exercise.

The new mesh operation is seen in the Project Tree hierarchy at the right.

NOTE:

Volumetric mesh operations may also be specified, driven by mesh edge length or number of
elements added.

Surface Approximation mesh operations enable control of various aspects of the mesh, including
aspect ratios as well as angular resolutions for true surface objects (e.g. circles, cylinders, spheres).



Section 6
Analysis Setup and Frequency Sweeps

+ The objectives of this section are to introduce
« the concepts of an analysis
+ analysis setup and control
+ frequency seeps and their specification
« checking designs for errors
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HFSS analysis is performed in the frequency domain. This means that raw HFSS
results are always for individual or swept frequencies. HFSS may also display
results as time responses for amplitude or impedance (TDR/TDT results). HFSS
can also export time domain circuit models for HSpice, PSpice, SpectreRF or other
general Spice codes.

A unique capability of HFSS since the initial release in 1990 has been adaptive
solution refinement to assure accuracy of results.

In the absence of user specified meshing operations and an automatically applied
mesh seeding driven by local material property and frequency, HFSS begins its
iterative adaptive solution refinement process with a course initial mesh. An analysis
is performed at a fixed frequency and the mesh is refined based upon errors in the
resulting Finite Element fields. The iterative process of analysis and mesh
refinement is continued to achieve user-specified convergence or stopping criteria.

This section covers an introduction to basic solution setup and some advanced
setup options for HFSS as well as the types of frequency sweeps available.

Since definition of solution setup and frequency sweep information completes the
“design capture” phase of the antenna design flow, the important capability of
checking a design for errors is also introduced.
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As for many other operations in HFSS there are multiple ways to add a solution setup in HFSS. The
easiest way is to use the context sensitive menu item “Add Solution Setup...” for the Analysis icon in
the Project Tree. This is shown in the graphic to the left. Alternately, you can use the main menu item
“HFSS - Analysis Setup > Add Solution Setup...”

The General tab of the solution setup dialog is shown to the right.

The Solution Frequency is the single frequency at which you would like the adaptive solution
refinement process to occur. The fields are saved for this analysis at the solution frequency.
Frequency sweeps will be defined separately from the Solution Setup dialog. For this RWG feed line
the cutoff frequency for the dominant mode is 10GHZ and for the next propagating mode is 20 GHz.
Therefore, set the Solution Frequency between these two values to 15GHz.

To perform only a 2D cross-section solution of the ports you would click in the Solve Ports Only
checkbox.

The Maximum Number of Passes field causes termination of the adaptive solution refinement
process after a user-specified number of iterations in this process have occurred, regardless of
whether or not the following S-parameter solution based criterion is achieved.

The Maximum Delta S Per Pass value causes termination of the adaptive solution refinement
process when the magnitude of change of all S-parameters is less than this user-specified value.

These are the highest level and most commonly used analysis setup controls. They have default
values you will typically need to change to meet the needs of you specific design. The Advanced
controls of the following two tabs in this dialog will be come more familiar to and may also be applied
more frequently as you become more experienced with HFSS.



Analysis Setup Details

Solutioh Setup x| Solution Setup x|
General Advanced |Ports | Defauis | General | Advanced FParts IDelau\tsl
r Initial Mesh Option:
r— Port Adapt Option:
¥ Do Lambda Refinement SRASER
Taiget (025 ™ Use free space lambda Port Field Aceuracy: | o
W Automatically Set Min/Max Triangles
—&daptive Option:
firimurn Murmber of Tiianglzs 100
Refinement Per Pass 15 % “
i i 500
Minimum Number of Passes ls— Il asirmum Mumber of Triangles:
Minimum Converged Passes: E]
™ Use Matrix Convergence Edlit ki atriz. Uem Bzl |
I™ Use Low-Drder Solution Basis
Use Defaults
Cancel Cancal

ANSOFT CORPORATION

The Advanced tab on the left has several fields that will be introduced but not explained in detail.

*The checkbox for Do Lambda Refinement is a toggle to turn on/off object local, wavelength based mesh seeding. If enabled,
Lambda Refinement causes the mesh in all objects to be generated with 3D edges less than the wavelength multiplied by
the Target value. The “wavelength” used local to each object is unique. It is the wavelength of a plane wave in the material of
the local object at the Solution Frequency.

«If the toggle Use free space lambda is checked, then the “wavelength” used for Lambda Refinement of all objects is the free
space wavelength at the Solution Frequency.

*The value specified for Refinement Per Pass is the percentage growth in mesh size for each adaptive solution refinement
pass. The HFSS default is 20%, which yields approximately a doubling of mesh size with four passes. The value of 15%
shown above yields a mesh size doubling with five passes.

*The value of Minimum Number of Passes indicates the adaptive solution refinement process should occur at least this many
times, even if the Maximum Delta S convergence criterion is satisfied with fewer passes.

*The Minimum Converged Passes value specifies the number of adaptive solution refinement passes for which the Maximum
Delta S convergence criterion must be satisfied before the refinement process is terminated. The HFSS default value is 1.
The value of 2 indicated in the graphic helps to avoid “false convergence” where one pass might satisfy the Delta S
convergence criterion but the next pass does not.

*The Use Matrix Convergence checkbox enables the ability to define custom Delta S type convergence criteria. For example,
the phase of S11 might be critical and other parameters meaningless.

*The Use Low-Order Basis check box changes the Finite Element E-field “shape functions” to linear rather than quadratic.
Since most antennas are distributed devices this option will not frequently be applied by antenna designers.

The Ports tab contains less information

*The Port Field Accuracy value can be interpreted as the accuracy desired for the characteristic impedance, Zo. This is
because Zo is a direct function of the fields and reflects first order error with respect to the fields, in contrast to the
propagation constant which is variational with respect to the fields and has second order error (greater accuracy).

*The Automatically Set Min/Max Triangles toggle is used to disable manual selection of the Min/Max Number of Triangles
values. For wave most wave ports the automatically set default values are appropriate. For some ports with high accuracy
requirements, these values may need to be manually increased. For some Lumped Gap ports it may be efficient (though not
required) to manually decrease these values.
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If you click the Save Defaults button on the Defaults tab, then the current solution
setup will be used as the default values. Each new solution setup you add in the
future will have these values.

This same scheme to define user preferences for multi-tab dialog box setups is
available several places in HFSS.
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The new analysis is shown in the Project Tree hierarchy.

As for designs and other entities, it is a very wise practice to immediately rename
your analyses.

Rename the analysis you just defined to “60dB_Convergence”.

It is important to note that multiple analyses may be defined for a design.

Each analysis has its unique setup and may perform adaptive solution refinement to
a different accuracy at a different solution frequency, etc.
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The easiest way to add a frequency sweep to an analysis is to use the context sensitive menu item “Add Sweep...” for the

individual analysis icon in the Project Tree; in this case the analysis icon named 50dB_Convergence. This is shown in
the graphic to the left. Alternately, you can use the main menu item “HFSS > Analysis Setup > Add Sweep...”

HFSS first performs the adaptive solution refinement process as defined in the analysis solution setup. It then uses the final

mesh from this process to perform the frequency sweep.

The frequency sweep setup dialog box is shown to the right.

There are three types of frequency sweeps

1.

2,

Piscrete sweeps perform an FEM solution at each and every frequency in the sweep. The fields may be saved at each
requency.

Fast sweeps perform several steps beyond a basic FEM solution to generate a frequency sweep centered at the
solution frequency of the solution setup. In a sense, this sweep “extrapolates” from the FEM solution at a single
frequency and frequency information extracted with these extra steps. Additional memory is required beyond that of an
individual FEM solution.

Interpolating sweeps perform FEM solutions at multiple discrete frequencies, which are automatically and adaptively
selected by HFSS. A rational function interpolation of the S-parameter and port (impedance and propagation constant)
results is generated. The selection of additional frequency samples is terminated with the specified error tolerance is
achieved or the maximum number of frequency samples has been reached. Unlike Fast sweeps, no additional memory
is required beyond that of an individual FEM solution.

For antenna designs it is unlikely DC results will be required, though the capability to generate a broadband sweep valid to

DC is present for Signal Integrity type applications. As the name would indicate, this is achieved through an automated
extrapolation to DC from low frequency results.

Several types of frequency sweeps are possible, including individual frequencies.

NOTE: It is difficult to know for any given design if it will be more efficient to use a Fast or an Interpolating sweep. The

Interpolating sweep is generally more robust over a very broad bandwidth. When large designs are analyzed and
access to large amounts of RAM becomes a primary concern the Interpolating sweep may be more appropriate.



Rename the Frequency Sweep
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The newly added frequency sweep is shown in the Project Tree hierarchy.

As for other entities, it is a very wise practice to immediately rename your frequency
sweep to a logical name you will recall later.

Rename your newly defined frequency sweep to “broadband_sweep”.

It is important to note that multiple frequency sweeps may be defined for each
analysis solution setup.



A Sanity Check
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The validity of the design (its readiness for performing analysis) may be checked. For users new to
HFSS, this is one of the most easily accessed key “self help” mechanisms.

Apply the main menu item “HFSS - Validity Check...” or use the mouse to select the toolbar icon
that looks like a big green check mark.

All aspects of the design capture process are validated. The results of this validation process are
displayed in a summary dialog box as well as in the Message Window (bottom left).

In this case, a warning message is displayed concerning overlapping boundary conditions. Recall
that we defined a PerfectH BC for the aperture which overlapped the PerfectH BC defined for the
infinite ground plane. This is only a warning, not an error.

Congratulations, you have now completed the Design
Capture phase of the antenna design flow!

It is important to remember the concepts learned to this point.

They will be applied to every antenna design you pursue with
HFSS.



Section 7
Perform and Track the Analysis

+ The objectives of this section are to introduce
« launching analyses
« tracking analysis progress and convergence
+ viewing log files, results tables and exporting data
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>

This section introduces a few concepts important for launching and tracking
progress of Analyses.



Launch the Analysis
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The most direct way to launch an individual analysis is to use the context sensitive
menu item “Analyze” of the individual analysis Project Tree icon. Simply right click
the icon in the Project Tree to access its context sensitive menu. All frequency

sweeps defined for an individual analysis are performed as part of the analysis
process.

If you use the context sensitive menu to the Analysis icon (one level in the

hierarchy above the individual analysis icons), then all analyses will be launched
sequentially.

When an analysis is launched a message appears in the Message Window (lower
left).

As an analysis is performed, the progress of its multiple steps are displayed in the
Progress Window (lower right). An analysis or its frequency sweep may be
terminated by clicking the “Abort” button in the Progress Window.
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The analysis log file is called the “Profile” and is viewed as the Profile tab in the Solution Data dialog
box.

The profile of an analysis may be viewed any time after the analysis has completed or as it is
dynamically updated during the analysis.

The profile for an analysis is most easily accessed via the context sensitive menu item “Profile...” of
the individual analysis icon in the Design Tree. Alternately, the profile tab of the solution data may be
accessed by applying the main menu item “HFSS - Results > Solution Data...”.

The profile includes time and memory information for each task in the analysis and frequency sweep,
as seen in the graphic to the right.

Recall that the HFSS Desktop environment manages all parametric solution results, that each design
may have multiple analyses and that each analysis may have multiple frequency sweeps. The fields
at the top of the Solution Data dialog box are used to select these three potential hierarchical aspects
of the databased solution data. For parametric designs, a separate dialog box is used to select
amongst multiple Design Variations for the top text field. The individual analysis and, if meaningful,
the analysis task are selected through drop down lists for the other two fields.

The large green check mark in the Solution Data dialog box show indicates the analysis has been
completed and valid solution data exists in the database.



Examine Convergence and Results
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Two other useful tabs of the Solution Data dialog box are shown here.

The left graphic shows the Convergence tab of the Solution Data dialog box. This
information display details the adaptive solution refinement process. The displays
are all described well and their meaning will be obvious from what has already been
learned in this multi-section exercise. Note the View selection that may set to Table
or Plot, where the Table view is shown in the graphic.

The graphic to the right shows the Matrix Data tab of the Solution Data dialog box.
Numerical solution results are displayed in tabular form and exported from this tab
in the Solution Data dialog box. The data displayed, its format and how to select the
data displayed should be intuitively obvious.

NOTE: It is important to recall the Matrix Data tab of the Solution Data dialog box is
the location from where data is exported. For example, S-parameter data in
touchstone/ClITlfile/etc format and Spice models for support of circuit design.



Section 8
Post Processing — Reports for Results

+ The objectives of this section are to introduce
«+ the display of HFSS analysis results
+ 2D XY plots
+ tailoring of plots to meet individual needs
+ frequency swept data as well a convergence data
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This section introduces the display of numerical results from HFSS analysis.

The tasks introduced in this section will be used quite regularly by all users of

HFSS.



Create a Report of the Results
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After an analysis has been performed, numerical results are available for display or
manipulation. The display of HFSS numerical results is called a “Report”.

The most direct way to create a report is to apply the context sensitive menu item
“Create Report...” of the Results icon in the Project Tree hierarchy. Alternately, the
main menu item “HFSS - Results > Create Report...” may be applied.

The dialog box shown on the right is used to select the type of data to be displayed
and the type of display desired.

Select to display modal S-parameters on a rectangular plot.



Specify Results to Plot
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This Traces dialog box selects the specific data to be displayed and is fairly easy to use after a brief
introduction.

At the top of this dialog box is a list of the traces that have been added to this plot. This graphic shows that
dB(S11) has been selected for display. Notice the use of the port name “p1” that we specified during definition
of the RWG excitation.

To the right of this list of traces are three buttons to manipulate traces, which may be applied either at the time
of definition or later when editing a plot.

In the Context group of fields the Solution field allow selection amongst the possibly multiple combinations of
analyses and their associated sweeps. The Domain field allows for display of either frequency or time domain
resul_lts. Time domain data is typically displayed for a broadband sweep from DC for signal integrity type
applications.

The results selection portion of the dialog has three tabs. The “Y” axis tab show in the graphic is displayed by
default. the three columns of this tab should be obvious in function. A trace is not added prior to clicking the
“Add Trace” button. Therefore, if your plot has no results displayed on it after clicking the “Done” button at the
bottom of this dialog, then the most likely cause is you forgot to explicitly add any traces. It may not be obvious
but in the Quantity column the CTRL and SHIFT keys may be applied in a Windows-standard manner to select
multiple entries, effectively adding multiple traces with a single click of the “Add Trace” button.

Select to display a frequency swept display of dB(S11), as shown in the displayed view of this dialog. You may
need to use the dropdown list horizontal scroll bar to assure the Solution field should select the entry
“50dB_Convergence : broadband_sweep”.

You may wish to examine the “Sweep” and “X” tabs of the data selection area in this dialog. You will note on the
Sweep tab that the only swept parameter for this analysis/sweep pair is frequency. On the “X” axis tab you will
note that frequency is selected. At this time do not change the specifications on either of these two tabs.



Rename the Report
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Your newly added plot should have one trace and it should look similar to the
graphic shown.

As has been strongly suggested many times in this exercise, it is an very wise
practice to immediately rename design entities in the Project Tree as they are
added. This is particularly important for Reports, since you will frequently create
multiple reports for each design. You will soon forget what results you have
displayed in plots with default names.

At this time, rename your new plot to “S(1,1) [dB]".

You will soon, if not already, desire to customize this plot.

*To modify the display of the individual traces, simply double click on the trace in the
plot or in the legend to the right of the plot. The legend is easier to assure you
double click on the trace you desire.

*To modify the X or Y axes (range of displayed data, major and minor grids, digits in
the labels, etc) simply double click on the numerical or textual axis labels.

*To modify the title at the top simply double click on it.



More Reports
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The graphic shows a set of reports created and modified.

Both S-parameters and port characteristics have been displayed for this aperture
antenna.

Reports have been named logically, scales changed for common sense viewing,
labels changed (digits, text, font, etc).

The plots have been “tiled”; a function found under the main menu items “Window
-> Tile Vertically/Horizontally”.
Windows may also be cascaded, which is useful for a larger number of displays.



A Smith Chart Report
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Create another report, only this time select Smith Chart for the Display Type.
Notice that the data selection area of the Traces dialog box has changed.

Select to plot S(p1,p1) for the same sweep as before.
You plot should look like the one shown at the right.

To establish good practices, rename you Smith Chart to “S(1,1)”.
Notice the icon for a Smith Chart is different than for a rectangular plot.



A Convergence Report
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Create one more report to display the results as they converge with adaptive
solution refinement pass number.

As before, select to plot S-parameters on a rectangular plot.

Unlike the previous two plots, in the Solution field use the dropdown list to select
“50dB_Convergence : Adaptive_1".

On the “Y” axis tab select to plot dB(S11).

You will not need to change anything on the “Sweeps” or “X”, since it is
automatically recognized that “pass” is a swept parameter of the adaptive solution
refinement process.

The plot should look like what is shown on the right.

To display symbols at each discrete value of the swept trace, double click on the
trace symbol in the legend to the right of the plot. On the Line Style tab of the dialog
box that appears, select to show symbols at every [one] data point.

Rename the report to “S(1,1) Convergence [dB]”



Section 9
Post Processing — Radiation

+ The objectives of this section are to introduce
+ the concept of a Far Field Setup
+ examining antenna parameters (gain, polarization, etc.)
« far field reports
+ both 2D and 3D displays

This section introduces the process required to generate and display far field

information.




Far Field Setup
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HFSS results are generated by the Finite Element Method, the key word being “finite”.

To generate far field results (at infinite distance from the antenna) a numerical transformation must
be accomplished, which essentially applies the EM equivalence principle. In this case, the equivalent
sources that exist on the radiation boundary condition are propagated to the far field through a
greens function. In this case, due to the specification of the infinite ground plane for the PerfectE BC,
the greens function includes the image of these equivalent currents in the ground plane and only
radiates energy into the upper half space.

To generate a far field, the relevant information is specified in the Far Field Radiation Setup dialog
box. There could be various unique far field setups for any given design so this information is given
its own icon in the Project Tree. To define a far field setup, apply the main menu item “HFSS>
Radiation = Insert Far Field Setup - Infinite Sphere...” or apply the context sensitive menu “Insert
Far Field Setup = Infinite Sphere” for the Radiation icon in the Project Tree.

The dialog is shown to the right with the information to be defined for this antenna. Define the angles
as shown and name the setup “far field at 2 deg”.

*The Infinite Sphere tab indicates over what angular range to compute far field data and at what
angular resolution.

*The Coordinate System tab allows the global (default) or user specified local coordinate system to
be used for the far fields. This can be useful for array design. HFSS generates far fields with both a
magnitude and phase. Two element patterns may be added via a vector sum for two elements with
their own local coordinates. This provides an array pattern for the two elements (of course mutual
coupling is ignored since it is simply a vector sum for two isolated elements).

*The Radiation Surface is an advanced tab that allows users to override the automated selection of
the surfaces for which the equivalence principle should be applied to form equivalent surface currents
and propagate them to the far field.



Examine Antenna Parameters
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Once a far field has been computed the antenna parameters result from well
defined mathematical operations on these field quantities.

To examine antenna parameters such as gain and polarization apply the main menu
item “Radiation - Compute Antenna/Max Params...”. Alternately, the context
sensitive menu item “Compute Antenna Parameters...” of the far field setup icon (in
this case, named “far field at 2 deg”) may be applied.



Antenna Parameters
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Prior to viewing the antenna parameters, two relatively simple dialog boxes appear.

The first simply selects the far field setup definition you wish to use.
The second selects the solution, frequency and variable values.
In this case, you need only click “OK” in each dialog box.

This is because you have only a single far field setup, a single analysis, fields saved
at only one frequency and you have not swept any variables for a parametric
analysis.

The far field parameters are shown at the right.



Add a Far Field Radiation Plot
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A 2D far field radiation plot will now be examined.

Use the “Create Report...” context sensitive menu of the Results icon in the design
tree to access the dialog box on the left. Use the two dropdown list fields to select
the proper type of plot to add.

When the Traces dialog box on the right is displayed the proper Context should be
displayed by default, since there is only a single field solution saved and a single far
field setup defined.

Click on the Sweeps tab and the display should look as shown on the right.

Note:

Phi is the default “Primary Sweep” variable and Theta as well as Freq are by default
specified as simple variables, which are variables with a discrete list of values.

When displaying multi-dimensional results on a 2D plot, such as this Radiation
Pattern plot, the data is represented as a discrete set of traces with the default
independent variable being the “Primary Sweep” variable.



Define the Far Field Radiation Plot
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Due to the symmetry of the entire geometry and the X-polarization of the RWG source, the radiated
E-fields should have a large X-directed component and a negligible Y-directed component. It is
desired to plot mag(Ex) as a function of Theta for a fixed value of Phi=0.

The first task is to change the “Primary Sweep” variable to be Theta. The top left graphic shows how
to accomplish this. Position the cursor over the “Name” field in the first row, which now indicates Phi.
Click the mouse and a drop down list appears in which you should click on the variable name Theta.
Theta will now be the “Primary Sweep” variable and Phi has become a general discrete variable.

The next task is to select only the single value of Phi=0. The center graphic shows how to
accomplish this. Select the Phi row by clicking on the square box to the left of the appropriately
labeled row. Uncheck the “All Values” checkbox above the right-most column of values, since by
default all values of the all variables are displayed. Assure the value 0 deg is highlighted in this
values list.

The Ang tab should be okay by default. If you examine it, this tab will indicate in desensitized text that
Theta is the independent variable for the plot.

On the Mag tab, specify to plot the magnitude of the X-component of the electric far field, as shown in
the graphic to the right.



Far Field Radiation Plot
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Rename your far field radiation patter plot to “Ex_vs_theta_with_phi_0".

It will appear in the Project Tree as shown on the left.
The plot should appear similar to what is shown on the right.

To modify the trace, double click on the trace symbol in the legend on the right.

To modify the scaling of the plot, double click on the black labels along the Theta=0
axis.



Add a 3D Far Field Plot
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The far fields may also be examined in three dimensions.
Two types of 3D plots are available but you will examine only a 3D Polar Plot.

Add a far field 3D polar plot, as shown in the dialog box on the left.

Specify to plot the same quantity we plotted in the previous 2D plot.

Since this is a 3D plot you will not need to change any of the default Sweeps or
adjust the Phi or Theta axes.



Field 3D Plot
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Rename you new 3D far fields plot to “Ex [mag]”.
It will appear in the Project Tree as shown on the left.

Your 3D far field plot should look like the graphic shown on the right. You can use
the same hot keys introduced in an earlier section for translation, rotation or zoom
(i.e. Shift, Alt, Shift+Alt). You should thy these hotkeys for your new 3D radiation
pattern display.

The easiest manner in which to modify the attributes of this display is to double
click within the plot scale legend. Alternately, you may apply the context sensitive
menu item “Modify Attributes....” of the plot’s icon in the Project Tree.



Section 10
Post Processing — Field Displays

+ The objectives of this section are to introduce
«+ plotting fields
+ on surfaces and in volumes
+ modifying field plots
« animation of field plots
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This section introduces a number of concepts for display of fields.

The previous section discussed far fields and this section will discuss near fields, or
“local” fields.

In the Project Tree hierarchy field plots will be located under the icon named “Field
Overlays”. This is because field plots are shown as “overlays” in the solid modeling
window of a design. This implies you view the geometry and local fields
simultaneously.

The examination of local field data can help to evaluate details of design behavior
and support predictive design refinement to eliminate effects due to locally high
electric or magnetic fields; capacitive or inductive effects, respectively.



Pre-Select Domain and Plot Fields
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When [local] fields are displayed by HFSS, you must pre-select the surface upon or
volume within which you wish to display the fields.

In the history tree expand the Planes hierarchy. Select the plane “Global: XZ". The
plane will be highlighted as shown in the left graphic.

The easiest manner in which to display fields in HFSS is to apply the context
sensitive menu “Plot Fields = xxx” of the solid modeling window. In this case,
selecting xxx=“Mag_E” is as good as any other selection.



© Alternate Fields Plot Requests
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There are also two alternate manners to request a fields plot once you have pre-
selected the plotting domain

1. apply the context sensitive menu “Plot Fields = xxx” of the Field Overlays icon
in the Project Tree.

2. apply the main menu item “HFSS - Plot Fields 2> xxx”



Specify What Fields to Plot
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The dialog box shown is presented for you to specify the field plot.
Click the “Specify Name” checkbox and name your plot “magE_XZ_plane”.

There is only one solution setup and only one fields solution saved at the adaptive
solution refinement frequency of 15GHz. Therefore, the only parameter you are free
to adjust is the phase. The default value of zero is as good as any other in this case.

The Quantity column is used to select the field quantity you wish to display. Mag_E
should already be selected, since we specified this quantity in the menu item that
yielded this dialog box.

The In Volume column is used to possibly limit the domain of the plot. For example,
even though you pre-selected the XZ-plane you could bound your field display to
only the intersection of the XZ-plane with the object “air” by selecting only that
object in this column. Assure that “All” is selected.



A Field Plot in a Plane
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Your field plot should appear as shown in the graphic.

Notice the high electric fields along the X-axis near the edge of the aperture. This is
expected due to the 90-degree metal corner with normal electric fields. Also, notice
the annular ring of light blue within the “air” object. You should expect the fields to
be lower in amplitude as the propagate away from the aperture into the air object
(toward the radiation boundary). The light blue annular rings will be separated by a
half wavelength.

The plot is also shown in the hierarchy of the Project Tree.

Plots that appear together under a Plot Folder in the Project Tree, in this case
named “E Field”, have identical attributes (e.g. scale, color, etc.).



Modifying Field Plots
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Plot attributes may be change by applying the context sensitive menu item “Modify
Attributes...” of the Plot Folder in the Project Tree. You may also simply double click
on the color scale within the plot window.

For your plot, change the scale to “Use Limits” and specify a range of zero to 4800.
Feel free to explore other attributes of your plot.

The scale aid your visualization of the fields by displaying less dark blue and more
of the red/yellow/green portion of the color spectrum.
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As mentioned during the discussion of the field plot definition dialog box, the phase
of the excitation is a specifiable parameter.

In HFSS this phase may be varied to produce an animated plot.

To animate a plot you can
1. apply the main menu item “View - Animate...”

2. apply the context sensitive menu “View - Animate” of the solid modeling
window.



Animation Setup and Export

Swept Variable | Design Point |

Swept variable: IPhasg j

Statt [ideg

Stop:  [180deg

Steps: 19

The dialog box at the top left will appear first. You should select the name of the
field plot, “magE_XZ plane” in this case.

The item selected in this list will control the variables presented for animation in the
next dialog.

The Setup Animation dialog box should display “Phase” as the default selected
“Sweep variable”. If not, select it in the dropdown list field. Name the animation (top
of the dialog box) to “10_deg_steps” and specify the steps to begin at 0, to end at
180 and have 18 steps.



Animation Setup and Export
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The animation will appear as shown on the right.

If you are viewing this in PDF format examine the accompanying AVI file
“‘magE_XZ_plane_Animation_10deg.avi’.

The dialog box on the left is used to control the animation as well as export it.
You will need to click the “Close” button to terminate the animation.

Animations of physical variables may also be defined, as will be introduced later.



Field Plot Visibility
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Since fields plots are “overlays” for the geometry it is often desired to turn them off
but save them for later viewing.

This is accomplished by toggling the visibility of the plot.

The visibility may be toggled by

1. applying the context sensitive menu toggle item “Plot Visibility” of the individual
plot icon in the Project Tree

2. applying the more general main menu icon “View - Visibility...” and the

associated dialog box, which can control the visibility of nearly everything in the
solid modeling window.

Turn off the visibility of your field plot.



A Volumetric Cloud Plot
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Fields may also be plotted in 3D.
How is this done with 2D visualization media (e.g. monitor, paper)?

Pre-select the two objects for the RWG feed and the air and plot exactly the same
Mag_E fields as before. Name the plot “magE_entire_volume”.

The display you receive will appear similar to the Cloud plot shown.
The density and size of colored 3D points shown in the graphic has been modified.

As you did previously, and may do for any field plot, you may adjust the plot
attributes to generate what you perceive as a “pretty picture.



A Volumetric Contour Plot
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Modify the attributes of this plot to show a 3D contour plot.
To obtain the plot show in the graphic, the following modifications were made
1. the number of colors was changed to 8 on the Color map tab

2. on the Plots tab the plot named “magE_entire_volume” was selected and the
IsoValSurface radio button was selected.

If you desire, 3D plots may also be animated with respect to phase (or physical
variables).



